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The object recognition technology from the ART tool enables you to auto-generate new hands-on simulation 
based exercises, demonstrations and step-by-step documentation simply by walking through a windows or 
web based application with the ART recorder tool activated.  

With ART you can customize the existing out of the box pre-built expert course content from Micro Focus and  
also enables you to create new content for both Micro Focus and Non-Micro Focus software applications.  

With the WYSIWYG Editor you can rapidly create and maintain step-by-step process documents and online 
courses with Multimedia content, Show-Me and Try-Me simulations and assessments. Track Compliance by 
exporting content as SCORM files for upload into your Learning Management System (LMS).   

 

ART Product homepage 
www.microfocus.com/en-us/education/art  
 
ART LMS Course Content Pack Samples  
for customer Learning Management System  
www.microfocus.com/software/artsamples 

Online Technical ART Support 
www.microfocus.com/software/art/art54/onlinesupport 
 
ART Documentation 
www.microfocus.com/documentation/ART/  
 
Micro Focus Education website 
www.microfocus.com/training    
Click here for Learning paths and Certifications 
Education Local contacts  
 

YouTube 
ART playlist ς Youtube 
Join the Software Education Channel on 
YouTube  
 

 

 

 

 

 

https://www.microfocus.com/en-us/education/art
http://www.microfocus.com/software/artsamples
http://www.microfocus.com/software/art/art54/onlinesupport
https://www.microfocus.com/documentation/ART/
http://www.microfocus.com/training
https://inter.viewcentral.com/events/uploads/microfocus/certifications.html
https://microfocus.viewcentral.com/events/uploads/microfocus/contact.html
https://www.youtube.com/playlist?list=PL92KZZ3tyNdME1Gs4AHsL4nzQRqbzU7A0
https://www.youtube.com/playlist?list=PL92KZZ3tyNdME1Gs4AHsL4nzQRqbzU7A0
https://www.youtube.com/channel/UCyIyzdlQ8TqfbEZCIwWJU3w
https://www.youtube.com/channel/UCyIyzdlQ8TqfbEZCIwWJU3w
https://www.youtube.com/channel/UCyIyzdlQ8TqfbEZCIwWJU3w
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1 LƴǘǊƻŘǳŎǘƛƻƴ  

¢ƘŜ !ŘƻǇǘƛƻƴ wŜŀŘƛƴŜǎǎ ¢ƻƻƭ рΦпл 5ŜǾŜƭƻǇŜǊΩǎ Yƛǘ ό!w¢ύ ƛǎ ŀ ǎǘŀƴŘŀƭƻƴŜ ŘŜǾŜƭƻǇŜǊ ƪƛǘ ŦƻǊ ŎǊŜŀǘƛƴƎ ǘǊŀƛƴƛƴƎ 

and enablement materials.  This document contains the steps necessary to install the Adoption Readiness 

Tool ς ART together with the latest Micro Focus ART Template and ART Course Skin. 

Are you new to ART? Take the Free online training: Get Started with ART which can be launched directly 
from our Product Homepage www.microfocus.com/en-us/education/art 
The online course covers: 

¶ Installing ART and the post-installation steps 

¶ Record a step-by-step process and enhance it in the Editor 

¶ Publish a recording as a Show-Me, Try-Me simulation based exercise and other outputs 

¶ Create a training course, include pages, videos, simulations and an assessment  
 
 
How to publish and distribute your ART learning materials: 

1. Publish locally and transfer the published files to your target server/sharepoint/shared drive/etc. 
Publishing a local website support portal is only possible with the standard ART developer kit, not 
with the ART ELE Developer Kit. Samples of such a local websites published can be found on our 
samples site: www.microfocus.com/software/artsamples 
 

2. Publish the content locally and use the generated SCORM or AICC files to upload it into your own 
Learning Management System (LMS). The Micro Focus ART template is pre-configured to publish 
SCORM files and this can be changed through the template into AICC file format. 
 

3. Publish ART simulations as an MP4 videoΩǎ including voice narration or Text To Speech  
and upload it to your own video library, embed the video in your ART courses or upload the video to 
your own YouTube channel.  We have various free webinars you can follow to learn more. 
 

4. Use the hosted ART ELE Cloud portal which comes along with an integrated centralized version 
controlled repository and integrated webserver for one-click publishing of all content providing role-
based access for the learners. More information about ART ELE can be found on our product page 
www.microfocus.com/en-us/education/art 
 

 

  

https://www.microfocus.com/en-us/education/art
http://www.microfocus.com/software/artsamples
https://www.microfocus.com/en-us/education/art
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ART Webinars 

We recently delivered a series of free Expert ART Webinars to help you gain more in-depth knowledge of 

ART and learn directly from our ART experts.  

Watch the Webinar 

Boosting User Adoption  

with ART  

In this webinar for new customers, you will learn about: 

Effective on-boarding with simulation-based training; Auto-

Generate simulations, videos, JobAids and runbooks;  In-

Application Context Sensitive Help (CSH) for direct guidance; 

Customer Success Stories. If you prefer to join a live session, 

you can register your seat here. 

Watch Webinar 1 

Create a Product  

Demonstration Video 

Lƴ ǘƘƛǎ ǿŜōƛƴŀǊ ŦƻǊ ŜȄƛǎǘƛƴƎ !w¢ ŎǳǎǘƻƳŜǊǎΣ ǿŜΩƭƭ ǳǎŜ !w¢ ǘƻ 

Auto-Generate a Product Demonstration video, include voice 

narrations and a powerpoint slide. Our subject matter expert 

will share tips and tricks and will show how to add this video 

together with a Try-Me simulation into an ART Course 

module.  

Watch Webinar 2  

Create an  

Online Course 

Lƴ ǘƘƛǎ ǿŜōƛƴŀǊ ŦƻǊ ŜȄƛǎǘƛƴƎ !w¢ ŎǳǎǘƻƳŜǊǎΣ ǿŜΩƭƭ ǳǎŜ ǘƘŜ !w¢ 

editor to create an online course with multimedia content. 

Our expert will demonstrate how to add step-by-step 

simulation-based exercises, MP4 video files, YouTube movies, 

images, and documents to the downloads section of your 

course. 

Watch Webinar 3  

Create an  

Assessment Module 

Lƴ ǘƘƛǎ ǿŜōƛƴŀǊ ŦƻǊ ŜȄƛǎǘƛƴƎ !w¢ ŎǳǎǘƻƳŜǊǎΣ ǿŜΩƭƭ ŘŜƳƻƴǎǘǊŀǘŜ 

how to use the ART course editor to include knowledge 

checks and an asseǎǎƳŜƴǘ ƳƻŘǳƭŜ ƛƴ ȅƻǳǊ ŎƻǳǊǎŜΦ ¸ƻǳΩƭƭ ƭŜŀǊƴ 

how to add various types of questions into the assessment 

and add simulations as Test-aŜ ƛƴǘƻ ǘƘŜ ŀǎǎŜǎǎƳŜƴǘΦ ²ŜΩƭƭ 

also show you how to configure and generate the SCORM file, 

so that you can upload it to your Learning Management 

System and do full tracking and tracing on who passed the 

assessment. 

Watch Webinar 4  

Create a Process 

Runbook 

Lƴ ǘƘƛǎ ǿŜōƛƴŀǊ ŦƻǊ ŜȄƛǎǘƛƴƎ !w¢ ŎǳǎǘƻƳŜǊǎΣ ǿŜΩƭl show you 

how to create a very detailed business process using 

Runbook. Our expert will publish several ART simulations to a 

web server and include the URLs into the Runbook. The 

Runbook itself is maintained in MS Word. Micro Focus 

Professional Services is using this technology to create their 

own Runbooks to document complex, internal administrative 

ǇǊƻŎŜŘǳǊŜǎΦ ²ŜΩƭƭ ǎƘƻǿ ȅƻǳ ŀƴ ŜȄŀƳǇƭŜ ƻŦ ǿƘŀǘ ǘƘŜȅ ƘŀǾŜ 

done.  

 

https://attendee.gotowebinar.com/register/8253210664747711499
https://attendee.gotowebinar.com/register/8253210664747711499
https://attendee.gotowebinar.com/register/8253210664747711499
https://register.gotowebinar.com/rt/3806622908530101251
https://attendee.gotowebinar.com/register/6283066147641163024
https://attendee.gotowebinar.com/register/6283066147641163024
https://attendee.gotowebinar.com/register/6283066147641163024
https://attendee.gotowebinar.com/register/8336886798118285071
https://attendee.gotowebinar.com/register/8336886798118285071
https://attendee.gotowebinar.com/register/8336886798118285071
https://attendee.gotowebinar.com/register/5557619370751749647
https://attendee.gotowebinar.com/register/5557619370751749647
https://attendee.gotowebinar.com/register/5557619370751749647
https://attendee.gotowebinar.com/register/7685487731330321932
https://attendee.gotowebinar.com/register/7685487731330321932
https://attendee.gotowebinar.com/register/7685487731330321932
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2 Lƴǎǘŀƭƭŀǘƛƻƴ !ŘƻǇǘƛƻƴ wŜŀŘƛƴŜǎǎ ¢ƻƻƭ 

2.1 .ŀŎƪǳǇ ōŜŦƻǊŜ ȅƻǳ ƛƴǎǘŀƭƭ ǘƘŜ ǎƻŦǘǿŀǊŜ 

 

When you have been installing and using a previous version of ART on your PC, please be aware of 

the following: 

A. Any existing ART source files you will open with the new ART 5.40.8 software, will 
automatically be upgraded to ART 5.40.8 file format ŀƴŘ ŎŀƴΩǘ ōŜ ƻǇŜƴŜŘ ŀƴȅƳƻǊŜ ǿƛǘƘ ǘƘŜ 
previous version. We recommend you to back-up your ART source files before you start 
editing them with the new ART software. 
 

B. If you are have been creating and using a fully customized template with an older ART 
softwaǊŜ ǘƻ ǊŜŦƭŜŎǘ ȅƻǳǊ ŎƻƳǇŀƴȅΩǎ ŦƻƴǘΩǎΣ ƭƻƎƻΩǎ ŀƴŘ ŎƻƭƻǊǎ ƛƴ ǘƘŜ ǇǳōƭƛǎƘŜŘ ŎƻƴǘŜƴǘΣ  ȅƻǳ 
must export and back-up your template and skin before upgrading and installing the new 
ART software. Use the following steps to back-up your customized template and skin: 
1. Start ART and launch the Editor 

2. Select File>Preferences 

3. Select Manage Local Templates from the left menu 

 

4. Click the Export button and save the current customized template to folder where you 

want to save your current ART files, customized template and skin. 

5. Select Manage Local Custom Skins from the left menu  

6. Click the Export button and save the current customized skin to a folder where you want 

to save your current ART files, customized template and skin. 

7. Close the Editor 

8. Close ART 
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2.2 ¦ƴƛƴǎǘŀƭƭ ȅƻǳǊ ŎǳǊǊŜƴǘ !w¢ ǎƻŦǘǿŀǊŜ ŀƴŘ ǊŜƳƻǾŜ ǘƘŜ wƻŀƳƛƴƎ 5ŀǘŀ 
The next steps will describe how you should remove the current ART software and corresponding roaming 

data files. 

  

1. Uninstall the ART software through the windows configuration panel: Uninstall a 

program 

 
 

 

2. Uninstall the Capture Engine (if you have installed it earlier) through the windows 
configuration panel 
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3. Open the windows file explorer  

 
 

4. Navigate to folder  
C:\Users\<your name>\AppData\Roaming\Hewlett Packard Enterprise 
C:\Users\<your name>\AppData\Roaming\Micro Focus 
and remove any Adoption Readiness Tool (ART) related folders. If you installed both ART 
and ART ELE ensure to remove both folders from the roaming data folder. 
 

5. Navigate to folder C:\Users\<your name>\AppData\Roaming\  
and remove the Ancile folder  
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2.3 wŜōƻƻǘ ȅƻǳǊ t/ 
Ensure to reboot your PC before you continue the next steps of installing the software.  

2.4 Lƴǎǘŀƭƭ ǘƘŜ !w¢ {ƻŦǘǿŀǊŜ 

The basic installation consists of the following steps: 

1. Run the ART installer and additional patch   

2. Run the ART Capture Engine installer  

3. Import the ART Template  

4. Import the ART Course Skin  

5. Set the ART Editor preferences 
 
 

After the import the skin is located physically under the roaming data folder:  
C: \ users \ <your name> \ AppData \ Roaming \ Micro Focus \ Adoption Readiness 

Tool \ version 5.40 \ Skins \ Course \ Custom  
 

After the import the template is located physically under the roaming data folder:  
C: \ users \ <your name> \ AppData \ Roaming \ Micro Focus \ Adoption Readiness Tool \ version 

5.40 \ Templates  
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2.5 wŜŎƻǊŘƛƴƎ ƻƴ {ƛƭƪ/ŜƴǘǊŀƭ ŀǇǇƭƛŎŀǘƛƻƴ  
In case you are recording on SilkCentral, you need to include the SilkCentral profile: 

1. Navigate to folder: Step 2 Capture Engine installation 
2. Select the MicroFocus Silk Central_19.cea  file and download it via the menu on the upper right 

corner 
3. Before continuing, ensure you are not recording and the ART application is closed. 
4. Paste the .CEA file into folder: 

c: \users\<your name>\appdata\Roaming\ANCILE\CaptureEngine\<version>\configuration\Data\Settings\CEA\ANCILE 
5. Start a new recording and use Internet Explorer.  

Now the data from the .cea file will be imported into the capture engine and is used during 
recording to optimize the recording actions. 
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2.6 ¦ƴȊƛǇ ǘƘŜ ƭƻŎŀƭ ƘŜƭǇ ŦƛƭŜǎ 

The following steps describe how to install the local help files on your PC. 

1. Unzip the file  ART5.40.2Help.zip  that you can find in the installation folder 
Step 4 LocalHelpFiles Installation  

2. Navigate to the root of the unzipped help files and select the index.html file.  

3. Open this file with the Internet Explorer  

4. Add this page to your Internet Explorer favorites. 
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2.7 ²ƛƴŘƻǿǎт t/ ŀƴŘ ǊŜŎƻǊŘ ǾƻƛŎŜ ƴŀǊǊŀǘƛƻƴǎ π Lƴǎǘŀƭƭ [!a9 ǘƻ ƎŜƴŜǊŀǘŜ atо 
With ART you can record your voice to the steps in your step-by-step ART recordings and to the pages in 

your ART course files. By default on a Windows 10 PC, ART will record this in MP3 files and can be played 

natively by your browser. However if you use an older Windows 7 PC the voice narration files will be 

generated by ART in WMV file format which requires Flash to play them and that is not being supported 

anymore by most browsers. To avoid this problem we recommend you configure ART to produce MP3 sound 

files using the LAME encoder. In the following section is described how to copy the LAME encoder files to the 

ART bin folder to ensure that ART will produce MP3 sound files for the recording sound/voice narrations in 

ART.  

1. Stop the ART Editor 

2. Open the Internet Explorer  

3. Search for downloading the lame.exe and lame_enc.dll. 

4. You will find for example sites like: 

https://www.giga.de/downloads/lame/ 

From where you can download the 64bits version from Windows that contains both the lame.exe 

and lame_enc.dll. Note: You can also copy the two lame files from the step 4 folder of the ART 

installation you downloaded from the ART FTP 

5. A zip file will be downloaded to your PC 

6. Unzip the zip file and you will see the two main files 

lame.exe and LAME_ENC.DLL 

 

7. Select and copy both lame.exe and LAME_ENC.DLL  

 

8. Navigate to the folder:  

C:/Program Files (x86)/Adoption Readiness Tool/Client/bin 

and paste both LAME files into the bin directory. 

9. If the ART Editor is running, restart the Editor for the changes to take effect. 

Note: Once you have installed LAME, all voice recordings you will do with ART will be encoded as MP3 files. 

To be able to playback sound correctly in the show-me version of your locally published simulation you need 

to configure flash on your PC which is described in one of the previous installation steps.  

  

https://www.giga.de/downloads/lame/
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2.8 /ƻƴŦƛƎǳǊŜ ǘƘŜ LƴǘŜǊƴŜǘ 9ȄǇƭƻǊŜǊ ŦƻǊ ǾƛŜǿƛƴƎ ƭƻŎŀƭƭȅ ǇǳōƭƛǎƘŜŘ !w¢ ŦƛƭŜǎ 
Make the Internet Explorer (IE) the default browser for viewing locally published simulations, courses and 

websites. To be able to view the published ART content you need to make several changes in the IE settings 

using the steps below: 

1. Launch the Internet Explorer 

2. Select in the right-upper corner the wheel (tools)  
 

3. Select Internet Options Advanced 
 

4. Scroll down to the Security Section and enable also the following option: 
   άAllƻǿ ŀŎǘƛǾŜ ŎƻƴǘŜƴǘ ǘƻ Ǌǳƴ ƛƴ ŦƛƭŜǎ ƻƴ Ƴȅ /ƻƳǇǳǘŜǊέ 
 

 
5.    άClick the OK button 
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2.1 /ƻƴŦƛƎǳǊŜ DƻƻƎƭŜ /ƘǊƻƳŜ ŦƻǊ ǾƛŜǿƛƴƎ ƭƻŎŀƭƭȅ ǇǳōƭƛǎƘŜŘ !w¢ ŦƛƭŜǎ 
Best practice is to use the Internet Explorer for viewing locally published ART HTML files (see previous 

paragraph). When you somehow have to use the more secure Chrome browser you need to include an Add-

in which allows viewing HTML files locally. Here are for example two possible Add-ƛƴΩǎ ȅƻǳ ŎƻǳƭŘ use:  

https://chrome.google.com/webstore/detail/local-explorer-file-manag/eokekhgpaakbkfkmjjcbffibkencdfkl 

https://chrome.google.com/webstore/detail/enable-local-file-

links/nikfmfgobenbhmocjaaboihbeocackld/related 

 

2.2 /ƻƴŦƛƎǳǊŜ CƛǊŜCƻȄ ŦƻǊ ǾƛŜǿƛƴƎ ƭƻŎŀƭƭȅ ǇǳōƭƛǎƘŜŘ !w¢ ŦƛƭŜǎ 
Best practice is to use the Internet Explorer for viewing locally published ART HTML files (see previous 

paragraph). When you somehow have to use FireFox browser you need to perform the following steps: 

1. Open new Firefox tab. 
2. In the URL enter:  about: config 
3. Click "I accept the risk" button 
4. Locate "privacy.file_unique_origin" (BY default is set to TRUE) 
5. Right-click and select Toggle, value should become FALSE. 
6. Launch the course/simulation again 
 

2.3 /ƻƴŦƛƎǳǊŜ 9ŘƎŜ ŦƻǊ ǾƛŜǿƛƴƎ ƭƻŎŀƭƭȅ ǇǳōƭƛǎƘŜŘ !w¢ ŦƛƭŜǎ 
Best practice is to use the Internet Explorer for viewing locally published ART HTML files (see previous 

paragraph). When you somehow have to use Edge browser you need to perform the following steps: 

 

1. Close Microsoft Edge. 
2. Make note of the location of the Microsoft Edge (msedge.exe) application.  
3. Locate the Microsoft Edge shortcut on your desktop or in your Start menu. 
4. Right click on the shortcut. 
5. Select Properties. 
6. Select and copy the data in the Target field on the Shortcut tab. 
7. Paste the data into a new text file. 
8. Remove the msedge.exe from the end of the text. 
9. Click the Windows Start button. 
10. Type cmd in the Search field.  
11. Press the Enter key to start a command prompt and select Run as Administrator. 
12. In the command prompt type: 

cd <Microsoft Edge application path> 
Example: cd C:\Program Files (x86)\Microsoft\Edge\Application\  

13. Press the Enter key. 
14. In the command prompt type: msedge -allow-file-access-from-files 
15. Press the Enter key. 
16. Microsoft Edge will launch, and will now be able to display uPerform content locally. 

Note: The course must be opened in this browser window that was launched via the command prompt. 
17. In the URL field, use the path to the index.htm file of the locally published simulation or course 

Examples:  
C:\Users\ [username]\Documents\Course_Name\course\html\ index.htm  
C:\Users\ [username]\Documents\Document_Name\sim\html\ index.htm 

 

https://chrome.google.com/webstore/detail/local-explorer-file-manag/eokekhgpaakbkfkmjjcbffibkencdfkl
https://chrome.google.com/webstore/detail/enable-local-file-links/nikfmfgobenbhmocjaaboihbeocackld/related
https://chrome.google.com/webstore/detail/enable-local-file-links/nikfmfgobenbhmocjaaboihbeocackld/related
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2.4 DŜǘ ǿŀǊƴƛƴƎǎ ƻƴ ǎǘŜǇǎ ǿƛǘƘ ǘƻƻ ƳǳŎƘ ǘŜȄǘ 
Best practice is to ensure you get to see warnings in the steps that have too much text. Use the 

File>Preferences editor to set the correct Filters to be able to see these warnings. 
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2.5 !ŘƧǳǎǘ ȅƻǳǊ 5ƛǎǇƭŀȅ {ŎŀƭƛƴƎ ǘƻ млл҈ 
To ensure the red arrow pointers in the auto-generated screenshots published in the Job-Aid documents will 

be placed correctly, you need to set your monitor display scaling to 100%. Right-click on your main desktop 

and select Display Settings. Below an example: 

  

  

 

2.6 wŜŎƻǊŘŜǊ ¢ǳƴƛƴƎ hǇǘƛƻƴǎ 
The recorder tuning option allows you to specify how you want the recorder to handle certain actions during 

the recording process. These options are useful for when you want to record supported target applications, 

as well as record unknown and inaccessible controls.  
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2.7 wŜŎƻǊŘƛƴƎ ƻƴ WŀǾŀ ŀǇǇƭƛŎŀǘƛƻƴǎ 

Note: You can skip this section when you are not planning to record on Java Applications. 

When you first record a Java application, the ART Recorder will detect if Java Access Bridge (JAB) has been 

configured appropriately for the Java application being recorded. If the application detects that JAB has not 

configured properly, a message appears advising that JAB needs to be configured for the Java Runtime 

Environment (JRE). The message may be similar to: "For best results recording this application, configure 

Java Access Bridge into this Java Runtime Environment." 

 

Enabling Java Access Bridge with Administrator Permission on your PC 

1. Browse to the application's installation folder. 

C:\Program Files (x86)\Adoption Readiness Tool 

2. Double-click the file: jinitcfg.exe 

3. Click Next. 

4. Select the Java Runtime Environment used to run the Java application and the corresponding JAB 

version. If the JRE path you need to configure is not listed, you may also manually locate the JRE (if it 

is in a self-contained application) by clicking the Browse button. 

5. Select Always replace existing files. 

6. Click Next. 

7. Click Next. 

8. Click Finish after the configuration is complete. 

9. Start the ART recording process again. 
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Enabling Java Access Bridge using Jabswitch during Recording without Administrator Permission 

Beginning with version 5.4, JRE 1.7_06, is shipped with JRE and provides the jabswitch tool to enable and 

disable Java Access Bridge (JAB). Jabswitch allows an author in certain circumstances to enable or disable 

JAB without administrator permission. The Jabswitch process only works with JRE 17.06 or higher.  

1. When you first record a Java application, the Recorder will detect if JAB has not been properly 
configured and the following message appears: "For the best recording results, Java Access 
Bridge needs to be configured into JREs on the system. Do you want to stop recording and 
proceed with the configuration?" 

2. Click Yes 

3. The Recorder stops and the document and all the steps recorded up until this point opens in the 
Editor. 

4. After the JAB has been enabled, a screen appears stating: "Java Access Bridge configuration is 
complete. For best recording results, please close and re-open the following applications." 

5. This message lists all the Java applications running when you clicked the "Yes" button in Step 2.  

6. Click OK. You will have to close the applications manually. This window can also be closed by 
clicking the "X" in the upper-right corner. 

7. Click OK 

8. Perform one of the following: 

If Then 

The application is currently run as an 
administrator or if the current user is in an 
administrator group 

1. JAB will update automatically 

in the background. 

 
2. Continue editing or recording. 

The current user is in an administrator group, 
but User Account Control setting is set to 
"Default" or "Always notify" 

1. Go to Step 9. 

The current user is not in an administrator group, 
" 

1. Go to Step 11. 

 

9. Click Yes to the User Account Control message so the application can make changes to your PC. 

10. After the changes are made, you can continue editing. 

11. Enter the administrator password in the User Account Control  window, Click Yes. 
 

Note: If "No" is clicked in Step 9 or Step 12, recording will resume, but the next action on the Java 

application will be captured incorrectly. The message asking a user if they want to stop recording and 

configure JAB will not appear again unless the user stops the recording and re-creates it. 

 

 

https://uperformhelp.ancile.com/hc/en-us/articles/Step9
https://uperformhelp.ancile.com/hc/en-us/articles/Step11
https://uperformhelp.ancile.com/hc/en-us/articles/Step9
https://uperformhelp.ancile.com/hc/en-us/articles/Step12
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2.8 wŜŎƻǊŘƛƴƎ ƻƴ ŀǇǇƭƛŎŀǘƛƻƴǎ ƛƴ ŀ ±ƛǊǘǳŀƭ wŜƳƻǘŜ [ŀō ŜƴǾƛǊƻƴƳŜƴǘ 
To ensure that the ART recorder will capture the right properties of the buttons and fields that you are 

clicking on during a recording of a step-by-step process on an application that is running inside a remote 

virtual lab environment, you need to install ART within that virtual lab environment. 

When you try to record with the ART from your local PC on a remote virtual lab environment, ART will not be 

ŀōƭŜ ǘƻ ǊŜŎƻƎƴƛȊŜ ǘƘŜ ƻōƧŜŎǘǎ ƛǘΩǎ ŎƭƛŎƪƛƴƎ ƻƴ ŀƴŘ ǿƛƭƭ ƴƻǘ ōŜ ŀōƭŜ ǘƻ ŎǊŜŀǘŜ ǘƘŜ ŎƻǊǊŜŎǘ  ŀǳǘƻ-generated action 

instructions.   

Authors can use ART client software from a 32-bit or 64-bit Terminal Server to support the generation of 

ŎƻƴǘŜƴǘΦ !w¢ Ƙŀǎ ōŜŜƴ ǘŜǎǘŜŘ ŀƎŀƛƴǎǘ ²ƛƴŘƻǿǎ ¢ŜǊƳƛƴŀƭ {ŜǊǾƛŎŜǎ όнллуύ ŀƴŘ /ƛǘǊƛȄ ·Ŝƴ!ǇǇϰ όǾпΦрύΦ ²Ŝ ǿƛƭƭ 

support customers using newer versions of Citrix although they have not been tested. ART does not support 

application publishing, remote applications, or web gateways from a Terminal Server. The Citrix server 

technical specifications will vary depending on other applications in use on the Citrix server, as well as the 

number of planned concurrent ART authors. 

All target applications to be recorded with ART must also be installed on the Citrix instance. You cannot use 

ART installed on Citrix to record an application installed on the local computer. Also you cannot use ART 

installed on your local PC to record an application on the Citrix instance. 
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2.8.1  {ŜǘǘƛƴƎ ǳǇ ǘƘŜ wŜǎƻƭǳǘƛƻƴ ƻŦ ǘƘŜ ǊŜƳƻǘŜ ±a 
1.  First set your local PC system resolution to 1600 x 900. 
2.  From your local PC, open the Remote Desktop Properties and set the display to 1600 x 900. 
3. Connect now with RDP to the VM and you will see that the resolution of the desktop in the VM is 

automatically set to the same 1600 x 900 resolution 

 
 

2.8.2  /ƭŜŀƴǳǇ ŘŜ ±a ŘŜǎƪǘƻǇ ōŜŦƻǊŜ ǊŜŎƻǊŘƛƴƎ 
1. Hide your Windows Task Bar:  

a. Right-mouse click on the task bar and select properties, as shown in the following screenshot. 

b. Select the Auto-hide the taskbar check box, as shown in the following screenshot. 

2. Hide browser toolbars that you do not need so that you have more room on the screen for the 
application. 

3.  If you need to hide the icons on your desktop, right-click on the desktop and select View -> Show 
desktop icons to disable the option. 
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2.9 {Ŝǘ ȅƻǳǊ ŘŜǎƪǘƻǇ ǎŎǊŜŜƴ ǊŜǎƻƭǳǘƛƻƴ ǘƻ мслл Ȅ флл 
The default ART template is set to use a desktop resolution of 1600x900 so when you have selected a lower 

resolution on your desktop you will get an error at the start of your recording. Set your laptop/desktop 

display resolution to 1600 x 900. Regardless of how you connect to your environment, your desktop/laptop 

must be set to 1600 x 900 for recording. Even if you are using RDP to connect to the environment, you must 

still set your desktop resolution to 1600 x 900. 

 

2.10 5ŜǎƪǘƻǇ ǎŜǘǘƛƴƎǎ ōŜŦƻǊŜ ǊŜŎƻǊŘƛƴƎ 
4. Hide your Windows Task Bar:  

a. Right-mouse click on the task bar and select properties, as shown in the following screenshot. 

b. Select the Auto-hide the taskbar check box, as shown in the following screenshot. 

5. Hide browser toolbars that you do not need so that you have more room on the screen for the 
application. 

6.  Its much better to clean-up your desktop before rŜŎƻǊŘƛƴƎ ŀƴŘ ƘƛŘŜ ƛŎƻƴǎ ȅƻǳ ŘƻƴΩǘ ƴŜŜŘΥ 
to hide the icons on your desktop, right-click on the desktop and select View -> Show desktop icons to 
disable the option. 

7. Close any applications you do not need which could trigger notifications to pop-up during your 
recording. 
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2.11 !ŘŘ ŀ tƻǿŜǊtƻƛƴǘ ǎƭƛŘŜ ǎŎǊŜŜƴǎƘƻǘ ƛƴ ȅƻǳǊ ǎǘŜǇπōȅπǎǘŜǇ wŜŎƻǊŘƛƴƎ 
You can also include one or more PowerPoint slides in your step-by-step recording. 

Just simply make a screenshot of your powerpoint and then paste that into the step of your choice.  

Below this process in some more details: 

1. Goto your target application, put it in full desktop screen mode and make a screenshot 
2. Goto the ART Editor where you see the steps from your recording (Simulation Tab) 
3. In the ART Editor select the step for which you want to change the screen capture 
4. Right click this step and copy it, now you still have the original step in case you need it later  
5. Right-click the step for which you want to replace the current screen  
6. Select Edit Step 
7. Select Screen 
8. Click the Paste buttonΦ ¢ƘŜ ƻǊƛƎƛƴŀƭ ǎŎǊŜŜƴǎƘƻǘ ƛǎ ƴƻǿ ǊŜǇƭŀŎŜŘ ǿƛǘƘ ŀ ǎŎǊŜŜƴǎƘƻǘ ȅƻǳΩǊŜ ȅƻǳǊ 

powerpoint 
9. Publish your recording and test the output 
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3 ¦ƴƛƴǎǘŀƭƭƛƴƎ !w¢ 
When your installation is not working properly after a PC migration for example you will need to remove all 

ART software components first and then re-install it. The next steps will describe how to perform this 

procedure. 

  

6. Uninstall the ART software through the windows configuration panel: Uninstall a 

program 

 
 

 

7. Uninstall the Capture Engine (if you have installed it earlier) through the windows 
configuration panel 
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8. Open the windows file explorer  

 
 

9. Navigate to folder  
C:\Users\<your name>\AppData\Roaming\Hewlett Packard Enterprise 
C:\Users\<your name>\AppData\Roaming\Micro Focus 
and remove any Adoption Readiness Tool (ART) related folders. If you installed both ART 
and ART ELE ensure to remove both folders from the roaming data folder. 
 

10. Navigate to folder C:\Users\<your name>\AppData\Roaming\  
and remove the Ancile folder  

 
11. Reboot your PC 

After the reboot you can start to install the ART software 
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4 bŜǿ CŜŀǘǳǊŜǎ !w¢ рΦплΦс   
ART 5.40.6 was released mainly to remove the dependency on Flash. Please see the provided release notes 
for a list of all the defects that were fixed as part of this release.  

4.1 tǳōƭƛǎƘ ŀ ǘȅǇŜ ŀŎǘƛƻƴ ǿƛǘƘƻǳǘ ǇǳōƭƛǎƘƛƴƎ ǘƘŜ CƛŜƭŘ 5ŜǎŎǊƛǇǘƛƻƴ ¢ŀōƭŜ   
When you have imported our default template as part of this installation procedure you need to check the 

setting of the  Hide Field Description Table . Ensure its enabled. 

 

  

Below examples with this feature enabled and disabled.  

Hide Field Description Table - enabled Hide Field Description Table - disabled 

 

 

 
After you made the above changes, close the template and save it  

  


